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Section : General English and Comprehension

Q.41 Select the option that can be used as a one-word substitute for the given group
of words.

A person who studies plants
Ans 1. Botanist

x 2. Ecologist

x 3. Geologist

x 4. Zoologist

Q.42 Select the most appropriate option to fill in the blank.

By the time we arrived, the guests had already

Ans 1 left
x 2. leaving
x 3. leave

x 4. leaves

Q.43 Select the most appropriate meaning of the given idiom.

Make a mountain out of a molehill
Ans 1. To exaggerate a minor problem

« 2. To undertake an ambitious project

« 3. To avoid interfering in a situation

x 4. To explore mountainous regions
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Q.44 Select the most appropriate option that can substitute the underlined word in
the given sentence.
The student’s diligent work led to excellent results.
Ans x 1. timid
x 2. careless

x 3. relaxed

« 4. thorough

Q.45 Select the most appropriate option to fill in the blank.

Meera wore a beautiful dress with embroidery.

Ans 1l intricate
X 2. uncouth
x 3. apprehensive

x 4. spacious

Comprehension:

Read the given passage and answer the questions that follow.

Mental well-being, encompassing emotional, psychological, and social health, is
fundamental to our overall health. It shapes our thoughts, feelings, and actions
daily. Far beyond the absence of mental illness, it represents a state where
individuals recognise their abilities, manage life's stresses, work effectively, and
contribute to society. In today's demanding world, mental health's significance is
increasingly clear. Pressures from academics, work, and social norms can trigger
challenges like anxiety and depression. The World Health Organisation reports
that one in four people will experience a mental health disorder, underscoring the
urgent need for awareness and understanding. Crucially, mental health profoundly
impacts physical health. Studies indicate that poor mental well-being elevates the
risk of chronic conditions such as heart disease, diabetes, and obesity. This
powerful mind-body connection demonstrates that stress and emotional distress
can manifest physically. Consequently, prioritising good mental health is vital for
both emotional equilibrium and physical wellness.

SubQuestion No : 46
Q.46 Select the most appropriate title for the passage.
Ans 1. The Foundational Role of Mental Well-being in Overall Health
% 2. The Interplay Between Stress, Mental Health, and Physical Illlness
x 3. Strategies for Achieving Emotional Equilibrium and Social Contribution

% 4. Understanding and Addressing Mental Health Disorders Globally



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

Comprehension:

Read the given passage and answer the questions that follow.

Mental well-being, encompassing emotional, psychological, and social health, is
fundamental to our overall health. It shapes our thoughts, feelings, and actions
daily. Far beyond the absence of mental illness, it represents a state where
individuals recognise their abilities, manage life's stresses, work effectively, and
contribute to society. In today's demanding world, mental health's significance is
increasingly clear. Pressures from academics, work, and social norms can trigger
challenges like anxiety and depression. The World Health Organisation reports
that one in four people will experience a mental health disorder, underscoring the
urgent need for awareness and understanding. Crucially, mental health profoundly
impacts physical health. Studies indicate that poor mental well-being elevates the
risk of chronic conditions such as heart disease, diabetes, and obesity. This
powerful mind-body connection demonstrates that stress and emotional distress
can manifest physically. Consequently, prioritising good mental health is vital for
both emotional equilibrium and physical wellness.

SubQuestion No : 47

Q.47 Why is prioritising good mental health considered vital, based on the information

provided?
Ans x 1. Because it eliminates all forms of social and academic pressures
x 2. Because it guarantees financial success and career advancement
x 3. Because it ensures complete immunity from all forms of illness

« 4. Because it is essential for both emotional equilibrium.and physical wellness
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Comprehension:

Read the given passage and answer the questions that follow.

Mental well-being, encompassing emotional, psychological, and social health, is
fundamental to our overall health. It shapes our thoughts, feelings, and actions
daily. Far beyond the absence of mental iliness, it represents a state where
individuals recognise their abilities, manage life's stresses, work effectively, and
contribute to society. In today's demanding world, mental health's significance is
increasingly clear. Pressures from academics, work, and social norms can trigger
challenges like anxiety and depression. The World Health Organisation reports
that one in four people will experience a mental health disorder, underscoring the
urgent need for awareness and understanding. Crucially, mental health profoundly
impacts physical health. Studies indicate that poor mental well-being elevates the
risk of chronic conditions such as heart disease, diabetes, and obesity. This
powerful mind-body connection demonstrates that stress and emotional distress
can manifest physically. Consequently, prioritising good mental health is vital for
both emotional equilibrium and physical wellness.

SubQuestion No : 48
Q.48 What is one thing that individuals in a state of mental well-being are able to do?
Ans 1. Recognise their abilities and manage life's stresses
% 2. Achieve extraordinary levels of wealth and fame

x 3. lgnore the needs and well-being of others

x 4. Completely avoid all forms of stress and pressure
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Comprehension:

Read the given passage and answer the questions that follow.

Mental well-being, encompassing emotional, psychological, and social health, is
fundamental to our overall health. It shapes our thoughts, feelings, and actions
daily. Far beyond the absence of mental iliness, it represents a state where
individuals recognise their abilities, manage life's stresses, work effectively, and
contribute to society. In today's demanding world, mental health's significance is
increasingly clear. Pressures from academics, work, and social norms can trigger
challenges like anxiety and depression. The World Health Organisation reports
that one in four people will experience a mental health disorder, underscoring the
urgent need for awareness and understanding. Crucially, mental health profoundly
impacts physical health. Studies indicate that poor mental well-being elevates the
risk of chronic conditions such as heart disease, diabetes, and obesity. This
powerful mind-body connection demonstrates that stress and emotional distress
can manifest physically. Consequently, prioritising good mental health is vital for
both emotional equilibrium and physical wellness.

SubQuestion No : 49
Q.49 What does mental well-being fundamentally encompass?
Ans x 1. Primarily physical health and the absence of disease
« 2. Emotional, psychological, and social health
x 3. Solely the absence of mental illness

% 4. The ability to achieve academic and professional success
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Comprehension:

Read the given passage and answer the questions that follow.

Mental well-being, encompassing emotional, psychological, and social health, is
fundamental to our overall health. It shapes our thoughts, feelings, and actions
daily. Far beyond the absence of mental iliness, it represents a state where
individuals recognise their abilities, manage life's stresses, work effectively, and
contribute to society. In today's demanding world, mental health's significance is
increasingly clear. Pressures from academics, work, and social norms can trigger
challenges like anxiety and depression. The World Health Organisation reports
that one in four people will experience a mental health disorder, underscoring the
urgent need for awareness and understanding. Crucially, mental health profoundly
impacts physical health. Studies indicate that poor mental well-being elevates the
risk of chronic conditions such as heart disease, diabetes, and obesity. This
powerful mind-body connection demonstrates that stress and emotional distress
can manifest physically. Consequently, prioritising good mental health is vital for
both emotional equilibrium and physical wellness.

SubQuestion No : 50

Q.50 Select the most appropriate ANTONYM of the given word.

Encompass
Ans 1. Exclude

x 2. Demand

x 3. Circulate

x 4. Contain

Section : General Hindi and Comprehension
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Comprehension:

e b AR IR AR g4l & 3R dfSre-

e oreg 3IST & ey I o1g form a1 & 3R 39aT &l ufawy o 511 & | MY 91 &1 3gd JAT!
oreg ‘el A g3 &,f5aept 319f @ ‘g & FpeTl g3’ | 3701 39T Frael ‘HIfE e ST A 3¢ I R
el I A AR STl &1 gl H feres & foTe QR QRIS QRIVIH AT HIfE 31 1 Tgwh ald
38 8139T ¢ 3 9 T & QX 31¢f o1 FRIuT g1 @ uTell | 39 Ufcersal ¥ A1 ol 7oA Q9 ¢ Al
srfcreanfter| gufere 8t 7 off ‘e’ oreg &1 91T & FH<i 2|

R d: s BT ¢ 3EH eldp JA9 A &1 91 IRAAH TR 7“2 v b ¢, e g
3R 3B IYBIUN &b 3:6d, 3! MfAfHAT 3R 37 IR AT, 3P 37 AR, HAYd A
o3l 3R A3, Uil 3R awdl, Sfrad #RuT 311G 48T A9t Y dieb? AR Plefi— RN,
ATy, g 3R aiaeh Fieis & 3fs el &1

SubQuestion No : 56
Q.56 'Y A< BT AT T & ?
Ans x1.Yel g3l
X 2. 51T fepar g3m
X 3. g3
v 4. 98 9§ Aoar gan
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Comprehension:

e b AR IR AT g4l & IR dfsre-

e oreg 3IST & ey I o1g form a1 & 3R 39aT &l ufawy o 511 & | MY 91 &1 3gd JAT!
oreg ‘el A g3 &,f5raept 319f @ ‘g & FepeTl g3 | 3701 39T Jrae ‘HIfeb ST A 3¢ I R
el I A AR STl &1 gl H feres & foTe QR QRIS QRIVIH AT HIfE 31 1 Tgwh ald
38 81 39T ¢ 3 1 T & QX 31¢f o1 U7 g1 @ uTell | 39 Ufcersal ¥ A1 ol 371 Q9 g Al
srfcreanfter| gufere B 7 off “Meres’ oreg &1 91T & FH<i 2|

R d: s BT ¢ 3EH eldp JA9 A &1 91 IRAAH TR 7“2 v b ¢, e g
3R 3b IYBIUN &b 3:6d, 3! MfAfhAT 3R 37 IR A, 3P 318 AR, HAYd A
o3l 3R A3, Uil 3R awdl, Sfrad #RuT 311G 48T A9t Y dieb? AR Plefi— RN,
ATy, g 3R aiae Feis & s M &1

SubQuestion No : 57
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Comprehension:

e b AR IR AT g4l & IR dfsre-

'R oreg 3RIST & ey I 1g form a1 & 3R 39aT &l Uiy o 511 & | Y 91 &1 38d JAT!
oreg ‘el A g3 &,f5raept 319f @ ‘g & FepeTl g3 | 3701 39T Jrae ‘HIfeb ST A 3¢ I R
el Al A JARR STl &1 gl H feres & foTe QR QRIS T, QRIvTH AT HIfE 31 1 Tgwh ald
38 81 39T ¢ 3 9 T & QX 31¢f o1 U7 g1 @ uTell | 3 Ufcersal § A1 ol 371 Q9 g A
srfcreanfter| gufere B 7 off “Meres’ oreg &1 91T & FH<i 2|

R d: e BT ¢ EH elep JI9 A &1 91 IRAAH IRATYT 7“2 v b ¢, e g
3R 3b IYBIUN &b 3:6d, 3! MfAfhAT 3R 37 IR A, 3P 318 AR, HAYd A
fopam3il 3R A3, Uiy 3R dwdl, Sfrad HRuT 3111S [T AUt Y dieb? AR Plefl— RN,
ATy, g 3R aiae Feis & s M &1

SubQuestion No : 58
Q.58 e ¥ Ygh AfeH &1 gATFard as g -
Ans x 1.3dqE
x 2. 3fam
¢ 3. IR
x 4. 9fasg
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Comprehension:

e b AR IR AT g4l & IR dfsre-

e oreg 3IST & ey I o1g form a1 & 3R 39aT &l ufawy o 511 & | MY 91 &1 3gd JAT!
oreg ‘el A g3 &,f5raept 319f @ ‘g & FepeTl g3 | 3701 39T Jrae ‘HIfeb ST A 3¢ I R
el Al A JARR STl &1 gl H feres & foTe QR QRIS T, QRIvTH AT HIfE 31 1 Tgwh ald
38 81 39T ¢ 3 1 T & QX 31¢f o1 U7 g1 @ uTell | 39 Ufcersal ¥ A1 ol 371 Q9 g Al
srfcreanfter| gufere B 7 off “Meres’ oreg &1 91T & FH<i 2|

R d: s BT ¢ 3EH eldp JA9 A &1 91 IRAAH TR 7“2 v b ¢, e g
3R 3b IYBIUN &b 3:6d, 3! MfAfhAT 3R 37 IR A, 3P 318 AR, HAYd A
o3l 3R A3, Uil 3R awdl, Sfrad #RuT 311G 48T A9t Y dieb? AR Plefi— RN,
ATy, g 3R aiae Feis & s M &1

SubQuestion No : 59
Q.59 &Y ¥ Ugwh vy a<g T 31ef g -
Ans 1. 9fdmHr
x 2. TR
x 3. g%ard
x 4.99G
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Comprehension:

e P 3R R AT gl & IR ffSie-

'R oreg 3RIST & ey I Tg form a1 § 3R 39T &l Ufaey o7 911 & | e 91 &7 3ogd AT
oIz ‘el & g3n &,f5ee! e & ‘e I MepeTl g3 | 3. IHpT Irae ‘HIfGe BT I g A1 Hifep
el Al A JARR St &1 gl & e & e “qRIg, QRIS “QRIVTH AT HTfE 34 T Ugth aid
38 81 39T ¢ 3 1 T & QX 31¢f o1 U7 g1 @ uTell | 39 Ufcersal ¥ A1 ol 371 Q9 g Al
srfcreanfter| gufere B 7 off ‘e’ oreg &1 91T & FH<i 2|

Rd: T2 1 el 3TGH oidp AT A 81 3791 IReTdd TR  “fie Ueb w1 &, Sid g
3R 3B IYPBRUN &b 336d, ITb! Ao 3R 39 IR A, 39 319 IR, JAYd A
fopam3il 3R AT, UferEdl 3R dwl, Sirad #RUT 1S fA8TH fAudT Y ciebr 3R Bleil &M,
fRAATe, g 3R aideh etz 3 e fd &1

SubQuestion No : 60
Q.60 & & fov 3ugh M &1 Ig7 Hifse-

Ans 1. A5
x 2. fog
x 3. PGIES

x 4. ®YH

Section : Basic Knowledge of Computer

Q.61 UHTUY T8 2019 ¥ 'Paste’ BHIS BT YA HI Y3 T aidl &7

Ans x 1. 98 CRC IR U HS LTSl cllF] Hl ¢
x 2. I8 Jciae fpu dave &l f3eiie Ha 8l
x 3. I8 SIRIAC B I Bl ¢

v 4. I8 faTaals I SRe &I sfagiic H IR &l ¢

0.62 fuferf&d ¥ d S1-91 faPbey, sfae $18 &I o1 § H3e 18 &1 ITAT FIA & & 1A
&) fAwfid &ar &2

Ans x 1. 53¢ 18 W e B1E H JaT & &1 131 & Bl 8l

X 2. PB3T BI3 BT 3YANT dbad 3iHaTs eioTaer~g & felv BT 3T JHbdT gl
X 3. 9BfeC BIs gRT <IoTaM B b felv {47 &I 3aeIasdr 78l aidl ol

@ 4. PIST B8 g fo-T SATST &b -RTI a1 B & felv U RATFdl 31afd (grace period) Y&l
&1 STt B
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0.63 3B ds-MARIT Uelib Al T, Aclae fHU IV SR B! F¢ (cut) I & ferv FAyferfEa
T A A= {6 HIAIS Aidhe BT 3uANT fHAT STdT 872

Ans x 1. Ctrl+C

x 2. Ctrl+V
x 3. Ctrl+Z

@ 4. Ctrl+X

0.64 Ifg¢ Windows 10 3iT9¥ e fRARend 9? fAeH &l date 3R time G &I NMANHAT @, dl
fafaf@d 7 @ $19-3 TR01 39 9fpAT B F&l adie A Ugd H3d &2

Ans x 1. Start B=] @I 3199 B3, Control Panel Bl Jcae B3, Date and Time W fdeids &3, 3R R
AfERT B HIfSHIS B & AU Change date and time S T 34T B |

« 2. Start 5 & 3199 &Y, Settings Pl Ucide B3, Time & language TR facid &3, fth Date &
time P Uclde B, 3R VTSN B! HIf3HIs B & [T Change §¢ BT 3T B |

x 3. Start H=J &l 3199 &Y, Settings Pl Uclde B3, System TR facie B, {2 Date & time Bl
Joide B3, 3R AT BT HifSBIE B3 & Al Change date and time §2 &1 34T B+ |

X 4. Start 5 &I 3199 &%, Control Panel &I Aaid &Y, System and Security, IR fdeic &3,
fY Date & time P! Aalde &Y, 3R AN BT IGeT- & U Modify e BT 34T B |
Q.65 HIsHIUIFE qraryise ¥ fpdl 9329 &l ofiedr A Hied & felv fog HIdIS didde &I
3YAT AT 51T AT &2
Ans x1.Ctrl+P
¢ 2.Ctrl+0
x 3.Ctrl +5

x 4. Ctrl +N

0.66 'Cc' &T Yuf &9 I &7?

Ans x 1. Connect copy (F-dc PidT)

x 2. Collaboration copy (PIciaiver ®idh)
x 3. Connection copy (B-1aelH ®idT)

& 4. Carbon copy (@18 &)
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0.67 HIgHINITUR a8 H A Hig[ar siagie &) Wied & fore fAgfearf@d ¥ @ 59 3ireE &1 39T
fopar mar 82

Ans x 1. File > New
« 2. File > Open
x 3. Edit > Open

x 4. File > Save

0.68 fgferRad & A oI=-91 3&7T, ATseR gl & Ufd fady ®9 A Adgefid & 3R sufere 33
Halgd ATgeR Y& 3UTAT b1 AdFHdl &2

Ans x 1. 944

X 2. BIRM

v 3. G 3R -

x 4. P
0.69 fferfEd & & o14-d fopar, ATHIATE MS Word & 31 STR[AC §-11 &1 Ugdl IRUT 872
Ans  x 1. STagHC I fic BT

X 2. STRIHC & AHIIC Bl BIHC BT

X 3. WISl A ¥ 'Open’ Aclae Bl

« 4. BISc L I 'New' BT TI9 BT IT 'New Document' HTgHhH TR faeid Bl

Q.70 UHUY USRI 2019 ¥, ‘Print Preview’ BT &1 3899 &1 87
Ans x 1. 3gLMe Pl dee Pl UfsT BT
x 2. Bgfe &I fodd) 97 Bifc § Id B3
« 3. T Bd I W2MT BT P (look) el BT
x 4. T P WE BIHC BIAT
Q.71 IfE 4fth 3 & HUR TS Yfth AR X[ D & a5 AR U WY U AW S1d &, dl g 7 d
S-91 fadey &l &2
Ans 1.3l 3ePI-3(eP] 3~0¢ TR fAwrfad &1 |
x 2. Ufth 3 31R W9 D &I Jelae &3, BT Ctrl + Shift + '+ GaTU|
x 3. I8 B, Tad & U I1Y foar ST I gl
X 4. GBIl 3R T &b AU Insert faBeq B BT HePT-3HelT 3T BY |
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0.72 Fgfaf@d & § SI9-91 fabey, JABIgs T8¢ §eBA (UPI) 1 Adiad qui Hdr g2
Ans x 1. fa<iTa ISR & folv U S1aAfesd THIUBROT Joura

@ 2. U HISTSel-A1eNR IYPTdT-T YUl Sl GoTd bl deblel & g¥didRUT & folU U & Aargal
UfAIb M I &5 I Wil Pl sNg bl Jfaen el &

x 3. 9B & T IRIAA JAR & folv Uep g er Jar

X 4. U PTAT qunell Sl I Pl Hifce B13 BT 3UANT B BA ZISTerl B bl Jfaer
T Rl 8

0.73 I 3uAPTHdl &I BIsd U1 (file path) B AR &, Al 98 HISHINWIT ds (Microsoft
Word) & siqiic $d 397 &3 A5dl &2

Ans 1. 'File' B T 3UGNT Bb 3R 'Open’ 3TQM BT Folde HIb
x 2. digd-bdles AR | 'Open document' et
X 3. TARBIA f3a1e IR STRIHC B ¢U BRb
X 4. STRIHC P! I8 U BH A TSP TR 397 3R 817 FIP
Q.74 MS d3 SipgHe H IR &vd IHT HI1Y B 3MTell (Keep Text Only) fddbey & fore fox
HIHI3 gifdde Polt WA ST 3UAVT fHAT STdT §2
Ans 1. Ctrl + Shift +V
x 2. Ctrl +Shift + O
x 3. Ctrl + Shift + H
x 4. Ctrl + Shift + Q
Q.75 UHUY ds 2019 H, Hed1-U1 SiagHc bl B3 Byl e BId U "Bldde (Collate)' AfET
&1 R BT &2
Ans x 1. SiagHC BT RV SGer
X 2. Bdcl Ugall 47 e BT
¢ 3. T B4l & fIU U7 Bl 31pAP (sequential) TI H FaRYT BN
x 4. JH-IAT Tl Ul b1 by Bl

Q.76 ISP &1 quf &Y T §?
Ans x 1.3cr¢ IfdT MargsR (Intranet Service Provider)
x 2. 8c34c AT WIfdsi (Internet Service Provision)

& 3 go¥ae gfdy Marse? (Internet Service Provider)

x 4. g2 fAeH Margsr (Internet System Provider)
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Q.77 UHUY Ul § TEXT Haeld &1 HIdTl g7

Ans 1. ISTTHS AT B TP JURATh® dR Bife cRe § H-1d¢ Bl &

x 2. CHC Pl 3TRBY AT ABRBY § Ha¢ B3l &
x 3. 3¢ Bl JWATHS ATl § B¢ BT &
x 4. TR Bl JWATHB ATl § B¢ BT &

Q.78 49 A 3271 UId B3I & felv 34T fHU 317 dIel YA ¢l bl ggdr Hifsrv)
Ans x 1. feidggd (Linkedin)
x 2. fger (Twitter)
x 3. BIg® (Facebook)
¢ 4. 30Td (Google)
0.79 Fufaf@d ¥ d oI4-A1 MdIgd RIS Riven 319-N gqd Jram ddef Jfaensi & foae
SITET SITdT € 31R U1 UeRuiss uRdel & 39T faan Sndr g2
Ans x 1.Ug[g8
@ 2. TIBRT 0S
x 3. 7T i0S
x 4. a8 BIF

Q.80 HATSER JYR&T $I INIWABI Bl UIAMND BV [T 872
Ans 1. B RRCH 3R A¢adh d 3G Ugd Bl Al
X 2. AR AT UItAB I &b ATfthdel ok 8B (GUI) H FeR BT

X 3. 8eC BARM Pl f F@I1

x 4. PYCR f3argy bl HSRUT §HAT Il

0.81 3MMf&d 3R ARG 315,000 ¥ U &I B &1 BT dd &1 & bt 39 B Bl 15
f&l & qRT B3 AHdl & STdf TR 3Pt o9 18 &N ¥ 1 S APl &1 Il $I YgrIar A
4 39 &1 B 6 &1 & Q1 FR @d &1 91 BT &=y rd HifSe|

Ans . 1.94,000
x 2.36,000
x 3.%5,000

x 4.37,000
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0.82 U T faebdl 180 ¥ Us gdldgif1d d¥d Wlgdl &1 3UYR 3UNAY T20 8198 39
gaag P ¥ ®I T300 ¥ S9dT1 & IR x% o Affd HIa1 &1 x ST 7414 F1d Hifw|

Ans »1.50
x2.70
x 3.40

x4.30

0.83 fAgfelfad aHi®or &1 H19 SiTd HIfSv]

2

3_ 2 i}_
-6+ (5) —2+0x8

Ans 1.7
x2.-3
x3.-5
x4.-2
Q.84 U Afb 6 He H TP AT QI B3 Hebdl &1 dg ITAT BT Ygell Ub-fdals T 60 km/hr B

dTel A 3R A9 & 40 km/hr 61 ATl F dF Bl &1 3B ATAT B Pl g3 (km H) ST
CAIE

Ans x1.274

x 2.279

v 3.270

x 4. 266

0.85 dIT 418y, A, B 3R C, U ¢l &bl 12 €¢ ¥ WR APd &l 3 He dPb Us 1Y Il & 414,
9189 C P §¢ B3 AT SATdT & d4T UTsq A 3R 91U B A9 9137 &I 10 & H R Jdbd &l
&dd TSy C gIRT cabl &l MR § fopda €¢ apdiin?

Ans . 1.120€¢
x 2.60 ¢
x 3.15 8¢
x 4.30 ¢
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0.86 fAHfeiRad &I g HISUI

2x12 —o2sxs+2x =
4 3 ) 2
Ans x1.-1

x2.0

& 3.1

x4.2

0.87 6.5,10.6, 20.2 3R a &I 314d 18 &1 a &I HIF siid HIfVI
Ans x1.36.7

x 2.337
x 3.35.7

w4347

0.88 &I IR fiig A A fiig B d® 30 km/h &I arel I Ieldl & 3% 50 km/h &) 91l F 919
3Tl &1 PR 61 39d =1l Fiad Hifsre)

Ans x1.355km/h
x 2.40 km/h
¢ 3.37.5km/h

x 4.42.5km/h

0.89 fAgferfad &1 A1 siid HIf3Te:

1850 - [450 - {210 - (90 - 60 - 9)}]
Ans x1.1519
x 2.1664
v 3. 1589

x 4.1449
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Q.90 Y& &Y I 31 BT 3 31, AT B a7 7Y & 3 3 F 12 99 A7 AP 8, 3R 37™a H
qd |1 g BT 9 AT, e I adH1 3G & 6 I A 6 99 HA &1 dham 3R Afd & adar
3 &1 F13T (991 #) S1d Hifsrel

Ans x1.20
& 2.16
x3.13

x 4.15

Q.91 & 3uficari A 3R B & dfi9 gU U T1d #, 80% HdGIdTH I 31941 Hd sTel, 57 3 2%
ud 31de "Ifd feU 3TUI A BT 12,544 7d e, 5l $of I 7dl ST 80% &AT1 3H A1 4§
HAGTAT3AT b1 Pl YT SiTd B3|

Ans x 1.20,000
v 2.16,000
x 3.25,000

x 4.22,000

0.92 fAgferfad &1 019 sird $Ifare:

1850 - [450 - {210 - (90 - 60 - 10)}]
Ans x 1.1520
X 2.1665
X 3.1450
v 4.1590
0.93 Tl avg &1 3ifPHd Yo 39S HI I A 75% AP 1 AT 9¥%g IR $B B o1 & d1q ot
GBIGR BT 5% T @19 Affd ardl &, A1 PR gIRT &I 718 e ufderd sird Hifsel

Ans x1.41%

v 2.40%
x3.42%

X 4.37%
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Q.94 AR 3R 39S AT B IdHI= AY BT AT 48 I 81 IR a &1, a1 H 31y RA 61 371y
&Y i 3 & ATt 36T I arT 3y HHE gl

Ans x1.12dY, 44 9y
x 2.20 a9, 36 9§
x 3.16 99, 40 99

v 4.10 94, 38 a9

0.95 IfE x BT 4% = 204 &, dl x BT I fHd-T &2
Ans x 1.10200
¢ 2.5100
x 3.10300
x 4.5200
Q.96 Uid JWAI37 &1 APTHel 655 &1 Ugell o1 AW BT HRId 75 & 3R I8 J&=A1 105 81 A9
&l YB3 BT 30 g1 HIf3ru)
Ans »1.200
X 2.201
X 3.181
x 4.180
0.97 U ATYY QT a¥g3il X 3R Y Ud® &l 31,700 § WGdl 81 9§ 370 4 A 4R U I
3ifpd BT &1 98 TG X B 21% 3R 52% $I I HUP Fe 3B 99dT & 31 B3 oft 7986

&1 @19 Affd S3d1 81 AT 98 Y BT 61% &) Uhd Be U d99dT &, di Y IR a1y gfdad sird
RIS

Ans x 1. 62%%
X 2. 61%
v 3 62.5%

x4 61.5%
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Q.98 U® PG U U &1 Yo, 3P Hd Yed H 40% AP Yidg Sl & 3R 30d It
el UX 20% 61 §e &dl ¢l AT 98 3111 &1 o1 Affd &var @, df 48 &1 JH g (R #)
=T 8?

Ans 11,2905
x 2.1,135
x 3.1,224

x 4.1,022

0.99 5t J@ & HIH A 18% $I dfg 30 3 U= & 41 7 18% B Fli & dfiw &1 3idR
303.12 &1 |&AT oiTd S|

Ans »1.842
X 2.848
x 3.840
x 4. 844
Q.100 Rq 61 A 30 d9d BT HIUTd 10 : 3 &1 I IAH 99d 12,000 &, dl A (X H) 1d
$ifarel
Ans x1.%26,000
«2.328,000
x 3.¥36,000

x 4.324,000
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